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Abstract

Granular hydrogels are jammed assemblies of hydrogel microparticles (i.e.,

"microgels"). In the field of biomaterials, granular hydrogels have many advantageous

properties, including injectability, microscale porosity, and tunability by mixing multiple

microgel populations. Methods to fabricate microgels often rely on water-in-oil

emulsions (e.g., microfluidics, batch emulsions, electrospraying) or photolithography,

which may present high demands in terms of resources and costs, and may not

be compatible with many hydrogels. This work details simple yet highly effective

methods to fabricate microgels using extrusion fragmentation and to process them into

granular hydrogels useful for biomedical applications (e.g., 3D printing inks). First, bulk

hydrogels (using photocrosslinkable hyaluronic acid (HA) as an example) are extruded

through a series of needles with sequentially smaller diameters to form fragmented

microgels. This microgel fabrication technique is rapid, low-cost, and highly scalable.

Methods to jam microgels into granular hydrogels by centrifugation and vacuum-

driven filtration are described, with optional post-crosslinking for hydrogel stabilization.

Lastly, granular hydrogels fabricated from fragmented microgels are demonstrated as

extrusion printing inks. While the examples described herein use photocrosslinkable

HA for 3D printing, the methods are easily adaptable for a wide variety of hydrogel

types and biomedical applications.

Introduction

Granular hydrogels are fabricated through the packing of

hydrogel particles (i.e., microgels) and are an exciting

class of biomaterials with many advantageous properties

for biomedical applications1,2 ,3 . Due to their particulate

structure, granular hydrogels are shear-thinning and self-

healing, allowing for their use as extrusion printing (bio)inks,

granular supports for embedded printing, and injectable

therapeutics4,5 ,6 ,7 ,8 ,9 . Additionally, the void space between

microgels provides a microscale porosity for cell movement

and molecular diffusion8,10 ,11 . Further, multiple microgel
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populations can be combined into a single formulation to allow

for enhanced tunability and material functionality8,10 ,12 ,13 .

These important properties have motivated the rapid

expansion of granular hydrogel development in recent years.

There is a range of methods available to form

microgels towards granular hydrogel fabrication, each with

its own advantages and disadvantages. For example,

microgels are often formed from water-in-oil emulsions

using droplet microfluidics4,11 ,13 ,14 ,15 ,16 ,17 , batch

emulsions7,18 ,19 ,20 ,21 ,22 , or electrospraying6,23 ,24 ,25 .

These methods yield spherical microgels with either

uniform (microfluidics) or polydisperse (batch emulsions,

electrospraying) diameters. There are some limitations to

these water-in-oil emulsion fabrication methods, including

potentially low-throughput production, the need for low-

viscosity hydrogel precursor solutions, and the high cost and

resources for setup. Additionally, these protocols may require

harsh oils and surfactants that must be washed from the

microgels using procedures that add processing steps, and

may be difficult to translate to sterile conditions for biomedical

applications in many labs. Removing the need for water-in-oil

emulsions, (photo)lithography can also be used, where molds

or photomasks are used to control the curing of microgels

from hydrogel precursor solutions1,26 ,27 . Like microfluidics,

these methods may be limited in their production throughput,

which is a major challenge when large volumes are needed.

As an alternative to these methods, mechanical

fragmentation of bulk hydrogels has been used to fabricate

microgels with irregular sizes19,28 ,29 ,30 ,31 ,32 . For example,

bulk hydrogels can be pre-formed and subsequently passed

through meshes or sieves to form fragmented microgels,

a process which has even been done in the presence of

cells within microgel strands33,34 . Bulk hydrogels have also

been processed into microgels with mechanical disruption

using techniques such as grinding with mortar and pestle or

through the use of commercial blenders35,36 ,37 . Others have

also used mechanical agitation during hydrogel formation to

fabricate fragmented microgels (i.e., fluid gels)31 .

The methods herein expand on these mechanical

fragmentation techniques and present a simple approach

to fabricate microgels with extrusion fragmentation, using

photocrosslinkable hyaluronic acid (HA) hydrogels as an

example. Extrusion fragmentation uses only syringes and

needles to fabricate fragmented microgels in a low-cost, high

throughput, and easily scalable method that is appropriate

for a wide range of hydrogels19,32 . Further, methods

to assemble these fragmented microgels into granular

hydrogels are described using either centrifugation (low

packing) or vacuum-driven filtration (high packing). Lastly,

the application of these fragmented granular hydrogels is

discussed for use as an extrusion printing ink. The goal of this

protocol is to introduce simple methods that are adaptable to a

wide variety of hydrogels and can be implemented in virtually

any laboratory interested in granular hydrogels.

Protocol

1. Fabricating bulk hydrogels inside of a syringe
using photocrosslinking

NOTE: An overview of bulk hydrogel fabrication inside a

syringe using photocrosslinking is shown in Figure 1. This

protocol uses norbornene-modified hyaluronic acid (NorHA)

to fabricate bulk hydrogels using a photo-mediated thiol-

ene reaction. Detailed procedures for the synthesis of

NorHA are described elsewhere38 . However, this protocol

is highly adaptable to any photocrosslinkable hydrogel. See

Discussion for more information.
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1. Predetermine desired concentrations of polymer,

crosslinker, and initiators for the bulk hydrogel

formulation. In this protocol, the hydrogel precursor

solution consists of NorHA (2 wt.%, ~25% degree of

norbornene modification), dithiothreitol (DTT, 6 mM), and

Irgacure D-2959 (I2959, 0.05 wt.%). Ensure that the

components (1 mL) are fully dissolved in phosphate-

buffered saline (PBS) within a microcentrifuge tube.
 

NOTE: When preparing the hydrogel precursor solution,

high molecular weight FITC-dextran (2 MDa, 0.1 wt.

%) can be added to the solution to visualize microgels

fabricated later in the protocol using fluorescent

microscopy.

2. Load a 3 mL syringe with the hydrogel precursor solution.

1. Remove the plunger from the back of an empty 3 mL

syringe and add a tip cap to the top of the syringe

barrel.

2. Use a 1,000 µL pipette to transfer the hydrogel

precursor solution into the syringe barrel with the tip

cap.

3. Hold the syringe barrel with hydrogel precursor

solution in one hand, with the tip cap facing down

and the open end of the barrel facing up. With the

other hand, return the syringe plunger to the opening

of the back of the syringe barrel. Gently push the

syringe plunger into the barrel, just enough to seal

the opening at the back of the syringe barrel.

4. Carefully holding the plunger and syringe barrel

together to ensure the back of the syringe barrel

is sealed with the plunger, invert the syringe such

that the plunger is facing down, and the tip cap is

now facing up. Remove the tip cap and gently push

the plunger into the syringe barrel until all the air is

removed from the syringe (just hydrogel precursor

solution remains).

5. Reattach the tip cap to the syringe. Ensure that the

hydrogel precursor solution is secured within the 3

mL syringe with a tip cap.

3. Form a bulk hydrogel within the 3 mL syringe.

1. Ensure proper personal protective equipment (PPE)

and safeguards are taken prior to turning on the

UV lamp. This includes wearing UV-protectant

eyeglasses and enclosing the lamp area to protect

others from UV light.

2. Calibrate the UV spot cure lamp to a light intensity

of 10 mW/cm2  using a radiometer.
 

NOTE: There will be light attenuation through the

syringe barrel. Prior to fabrication, determine the

percentage of light attenuation present using a

radiometer. Light intensity output from the spot

curing system should be adjusted accordingly to

account for such attenuation.

3. Place the 3 mL syringe loaded with the hydrogel

precursor solution under the UV spot cure lamp for

a desired amount of time to fully photocrosslink.

For the system described herein, NorHA hydrogel

precursor solution is exposed to UV light for 5 min

at an intensity of 10 mW/cm2 , which, based on

prior studies39 , was sufficiently enough time and

light intensity to ensure complete crosslinking as

determined by photocrosslinking oscillatory shear

rheology time sweeps.
 

NOTE: To ensure complete photocrosslinking within

the syringe, the syringe can be flipped halfway

through the photocrosslinking period.

https://www.jove.com
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4. Turn off the UV lamp and remove the syringe.

Ensure that the hydrogel is now photocrosslinked

within the syringe. This can be done by pulling back

the plunger and observing the hydrogel move as a

solid block rather than a viscous liquid.

 

Figure 1: Overview of fabricating bulk hydrogels inside a syringe using photocrosslinking. The figure depicts

(A) removing the plunger from the syringe, (B) securing the tip cap to the syringe barrel, (C) adding hydrogel precursor

to the syringe barrel, (D) returning the plunger to the syringe, (E) removing excess air and securing the tip cap, and (F)

photocrosslinking bulk hydrogel inside of the syringe. Please click here to view a larger version of this figure.

2. Fabricating microgels using extrusion
fragmentation

NOTE: An overview of microgel fabrication using extrusion

fragmentation is shown in Figure 2.

1. Remove the plunger from the back of an empty 3 mL

syringe. Secure a tip cap to the Luer-Lock.

2. Remove the tip cap from the syringe containing the

photocrosslinked bulk hydrogel. Line up the top of the

hydrogel syringe with the opening of the barrel on the

empty syringe.

3. Extrude the bulk hydrogel through the syringe opening

(no needle attached) into the barrel of the empty syringe.

Properly discard the syringe that is now empty (formerly

contained the hydrogel) into the proper waste stream.

4. Hold the syringe that contains the extruded hydrogel

such that the tip cap is facing down, and the barrel

opening is facing up. Using a 1,000 µL pipette, add 1.5

mL of PBS to the syringe barrel.

5. Align the syringe plunger with the opening of the barrel,

just barely pushing the plunger in enough to create a seal.

Invert the syringe such that the plunger is now facing

down and the tip cap is facing up, making sure to hold

the plunger and syringe barrel together in place so that

no hydrogel or PBS leaks out. Invert multiple times to mix

the fragmented hydrogel with the PBS added.

6. Hold the syringe such that the tip cap is facing up and the

plunger is facing down. Remove the tip cap. Very gently

push the plunger upwards to remove any air from the

inside of the syringe.
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NOTE: There will likely be a groove in the back of the

3 mL syringe that will require extra force to push the

plunger in. Very carefully push the plunger over the

groove. Any sudden or harsh amount of force will cause

the plunger to move too fast and possibly expel the

fragmented hydrogel suspension.

7. Extrude the fragmented hydrogel suspension through a

series of needles to create fragmented microgels.

1. Secure a blunt-tip 18 G needle to the top of the

syringe containing the fragmented hydrogel and

PBS. Remove the plunger from a fresh 3 mL syringe

and secure a tip cap to the empty syringe barrel.

2. Extrude the fragmented hydrogel suspension

through the 18 G needle into the back of the empty

syringe barrel. Discard the empty syringe and needle

into the proper sharps waste stream.

3. Hold the syringe that contains the fragmented

hydrogel suspension such that the tip cap is facing

down and the barrel opening is facing up. Align the

syringe plunger with the opening of the barrel, just

barely pushing the plunger in enough to create a

seal.

4. Invert the syringe such that the plunger is now facing

down, and the tip cap is facing up, making sure to

hold the plunger and syringe barrel together so that

no hydrogel or PBS leaks out.

5. Hold the syringe such that the tip cap is facing up and

the plunger is facing down. Remove the tip cap. Very

gently push the plunger upwards to remove any air

from the inside of the syringe. See the NOTE above

regarding gently pushing the syringe plunger inward

to prevent unwanted expulsion of hydrogel material.

6. Repeat steps 2.7.1-2.7.5 with a 23 G, 27 G, and 30 G

needle. Upon the last extrusion step (30 G needle),

extrude the fragmented hydrogel suspension into

microcentrifuge tubes. For the volumes described

herein, the final fragmented hydrogel suspension

volume will be ~2.5 mL, requiring two 1.5 mL

microcentrifuge tubes (volume split equally).
 

NOTE: No excessive force should be required to

extrude fragmented hydrogel suspension through

the needles. For best safety practices, it is

recommended to perform all extrusion fragmentation

steps inside of a chemical hood to provide

protection in the event of syringe over-pressurization

during extrusion. In addition, this process can be

easily performed in a biosafety cabinet/laminar

flow hood to maintain sterility during fabrication.

See Discussion for additional troubleshooting

suggestions.

8. Wash and isolate the fragmented hydrogel suspension.
 

NOTE: Washing fragmented microgels will help to

remove any unreacted polymer and crosslinker. In

addition, centrifuging will help to isolate the microgels

from the suspension by forming a pellet.

1. Using a microcentrifuge, spin down the fragmented

microgel suspension at 5,000 x g for 5 min.

2. Use a pipette to remove the supernatant. Add 1

mL of PBS to each microcentrifuge tube containing

fragmented microgels and vortex for 5-10 s.

3. Repeat centrifuging and washing with PBS 3x.

https://www.jove.com
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Figure 2: Overview of microgel fabrication using extrusion fragmentation. The figure depicts (A) extruding bulk

hydrogel into an empty syringe barrel and adding PBS, (B) securing a plunger in the syringe with fragmented hydrogel,

(C) attaching an 18 G needle and extruding fragmented hydrogel suspension into an empty syringe barrel, and (D)

repeating extrusion fragmentation steps with 23 G, 27 G, and 30 G needles, collecting fragmented hydrogel suspension in

microcentrifuge tubes on final extrusion. Please click here to view a larger version of this figure.

3. Characterizing fragmented microgels using
ImageJ

NOTE: An overview of characterizing the fragmented

microgels using ImageJ is shown in Figure 3, as well as

representative results for describing size distributions and

shapes within a batch of fragmented microgels. Microgels

should be fluorescently labeled prior to visualization. For

example, high molecule weight FITC-dextran (2 MDa) can be

encapsulated in the bulk hydrogel prior to fragmentation to

create fluorescein-labeled microgels.

1. Combine 20 µL of fragmented microgel suspension with

180 µL of PBS to create a dilute fragmented microgel

suspension. Vortex to mix thoroughly.

2. Transfer 50 µL of dilute fragmented microgel suspension

to a glass microscope slide.

3. Use an epifluorescent microscope to acquire images of

fluorescently-labeled microgels at 4x or 10x zoom.
 

NOTE: The microgel suspension should be dilute enough

such that neighboring microgels are not in contact with

one another, yet concentrated enough such that dozens

of microgels are visible in the viewport. The dilution

of microgel suspension can be adjusted accordingly to

achieve this.

4. Using ImageJ to analyze fragmented microgel particles.

Additional information on using the Analyze Particles

functionality in ImageJ can be found in the link provided

in the Table of Materials.

1. Open the images of microgels in suspension in

ImageJ.

2. Select Analyze > Set Measurements, Check Area,

Shape Descriptors, and Feret's Diameter. Click

OK.

3. Select Image > Type > 8-bit.

4. Select Image > Adjust > Threshold. Adjust the

threshold such that microgels are covered by a red

https://www.jove.com
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mask, and the background remains black. Click on

Apply.
 

NOTE: If any microgels are slightly overlapping, use

the Pencil Tool to draw a thin (<5 pixels) black line

between microgels to separate them in the black and

white image.

5. Select Analyze > Analyze Particles. Set Size

(pixel2 ) from 50-Infinity to reduce background noise.

Set Circularity to 0.00-1.00. Select Show Outlines

from the Dropdown menu. Check Display Results,

Exclude on Edges, and Include Holes. Leave the

remaining boxes unchecked. Click on OK.

6. A results display will open, including the area, shape

descriptors, and Feret's diameter information for

each microgel identified. Copy and paste the results

into a spreadsheet.

7. Determine the equivalent circular diameter for each

particle.

1. Obtain the image scale in µm/pixel from the

scale bar or the instrument information. Create

a column in the spreadsheet that converts the

area of each microgel from pixel2  to µm2 .

2. Use the area in µm2  to determine the equivalent

circular diameter of the microgel in µm (i.e., take

the square root of the area divided by pi, then

double it).

8. Use the µm/pixel scale to convert the Feret's

diameters (i.e., the longest distance between any

two points on the particle boundary) for each

microgel to a unit of µm.

9. Circularity ("Circ."), aspect ratio ("AR"), roundness

("Round"), and solidity values for each microgel can

be used as is direct from ImageJ.

10. Analyze the microgel population as desired,

considering the distribution of diameters (equivalent

circular and Feret's), circularity, aspect ratio,

roundness, and solidity.

https://www.jove.com
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Figure 3: Overview of characterizing fragmented microgel particles using ImageJ. The figure depicts (A) creating a

dilute suspension of fragmented microgel particles and using an epifluorescent or confocal microscope to image microgels

in suspension (scale bar = 500 µm), (B) converting to a binary image in ImageJ and analyzing particles (count, shape

descriptors, etc.), and (C) representative results. Error bars depict min and max with inner quartile ranges demarcated. A

population size of n = 100 microgels is shown. Please click here to view a larger version of this figure.

4. Assembling fragmented microgels into
granular hydrogels

NOTE: Two methods for the formulation of granular

hydrogels from fragmented microgels are presented, using

centrifugation and filtration. The method used will depend on

the desired microgel packing (i.e., filtration packs particles

more densely) and whether biological components are

included (i.e., centrifugation will retain components between

particles, whereas in filtration these may be lost). Prior work40

thoroughly describes comparative outcomes (i.e., mechanics,

porosity) for granular hydrogels formed from either centrifuge

or vacuum-driven filtration.

1. Option 1: Jam fragmented microgels using

centrifugation.

1. After removing PBS supernatant from the last

washing step, add 1 mL of PBS to each

microcentrifuge tube and resuspend the microgels.

2. Spin down the fragmented hydrogel suspension at

18,000 x g for 5 min.
 

NOTE: Slower centrifuge speeds can be used for the

jamming of microgels into granular hydrogels with

less dense packing if desired.

3. Remove the PBS supernatant.

4. Obtain a fresh 3 mL syringe and remove the plunger.

Use a metal spatula to scoop the fragmented

granular hydrogel out of the microcentrifuge tube

and transfer it into the back of the empty syringe

barrel. A pipette tip can be used to assist in

transferring the granular hydrogel into the syringe.

Return the plunger to the syringe. Now load the

fragmented granular hydrogel into the syringe, and

it is ready for use.

2. Option 2: Jam fragmented microgels using vacuum-

driven filtration. An overview of jamming by vacuum-

driven filtration is depicted in Figure 4.

https://www.jove.com
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1. Assemble and test the vacuum-driven filtration

apparatus.

1. Secure a Buchner funnel inside of a filter flask,

placing the filter adapter in between the funnel

and the flask opening.

2. Use tubing to connect the filter flask to a vacuum

line.

3. Place a membrane filter (0.22 µm) in the

Buchner funnel cup.

4. Turn on the vacuum line by opening the dial

valve. Test the connection by pipetting ~0.5 mL

of PBS onto the membrane filter and observe

that all the PBS goes through the filter and

collects in the bottom of the filter flask.

2. Turn on the vacuum line and ensure a complete seal.

Vortex the fragmented hydrogel suspension so that

microgels are suspended in PBS.

3. Using a 1,000 µL pipette, transfer the fragmented

hydrogel suspension onto the membrane filter

(0.22 µm). After transferring the entire microgel

suspension, wait for ~30 s for the vacuum to pull PBS

out of the fragmented hydrogel suspension. Turn off

the vacuum line.
 

NOTE: The time that the fragmented hydrogel

suspension sits on the membrane filter while pulling

vacuum can be varied. See Discussion for more

information and troubleshooting suggestions.

4. Obtain a fresh 3 mL syringe and remove the plunger.

Use a metal spatula to scoop the fragmented

granular hydrogel from the filter and transfer it into

the back of the empty syringe barrel. A pipette tip

can be used to assist in transferring the granular

hydrogel into the syringe. Return the plunger to the

syringe. Load the fragmented granular hydrogel into

the syringe, and it is now ready for use.

 

Figure 4: Overview of jamming microgels by vacuum-driven filtration to fabricate tightly-packed fragmented

granular hydrogels. The figure depicts (A) placing a membrane filter on the vacuum filtration apparatus, (B) using a pipette

to transfer fragmented microgel suspension onto the filter, (C) pulling the vacuum and waiting for microgels to jam and form

a granular hydrogel, (D) turning off the vacuum and removing fragmented granular hydrogel using a metal spatula, and (E)

using a metal spatula to transfer granular hydrogel to the syringe. Please click here to view a larger version of this figure.

https://www.jove.com
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5. Extrusion printing with granular hydrogel inks

NOTE: An overview of the extrusion printing process is

shown in Figure 5, including a representative print of a

star-shaped construct using fragmented granular hydrogels

jammed with vacuum-driven filtration. The printing workflow

consists of formulating an ink, planning the print design,

and then printing the ink based on the desired design41 .

If desired, printed granular hydrogel constructs can be

stabilized using photocrosslinking post-extrusion by adding

excess DTT (5 mM) and I2959 (0.05 wt.%) to the fragmented

microgel suspension prior to jamming. This will result

in photocrosslinked covalent bonds formed between the

microgels, leading to permanent stabilization of the granular

hydrogel construct.

1. Ink formulation

1. During the planning process, keep in mind the

properties of the ink to be used. To characterize

the ink, complete the rheological analysis of the

fragmented hydrogels to help inform the print

design process. Methods describing the rheological

characterization of granular hydrogels are described

elsewhere and can be adapted for this study40 .

2. From the rheological analysis, select a printing

platform and a series of initial print parameters.
 

NOTE: Due to the overall high viscosity and shear-

thinning properties of granular hydrogel inks, screw-

based extrusion printers are typically used.

2. Print design
 

NOTE: Repetier Host software (henceforth referred to as

3D printing software) is used for 3D printing applications

(steps 5.2-5.3).

1. Create the print designs through computer-aided

design (CAD) software. Users can create novel

designs from scratch or modify pre-existing designs,

such as from patient tissue scans or from

other users. For more information on creating

CAD designs, please refer to the following

references41,42 ,43 .

2. To process CAD models into G-Code, ensure that

the CAD file is saved in ".stl" format (Supplemental

File 1) and uploaded to the 3D printing software

by selecting the load button in the top panel or

selecting File > Load in the menu bar. This G-code

defines the printing path for the deposition of the ink.

An example .stl file of a hollow cylinder has been

included in the supplemental files.

3. Once an STL file has been uploaded to the 3D

printing software, navigate to the Slicer panel and

select Slic3r as the slicer option. Here, settings

such as nozzle diameter, layer height, print speed,

and extrusion rate can be adjusted based on ink

characterization and desired printing outcomes. In

this protocol, an 18 G needle (inner diameter of 838

µm) is used. Layer height is set to 1 mm, print speed

is set to 8 mm/s, and flow rate is set to 9 µL/s,

based on previous optimization39 . Numerical values

of parameters may be adjusted by ± 20% to account

for variations in the properties of granular hydrogel

inks.
 

NOTE: It is important to note that these settings

and the print design may need to be adjusted

through iterative experimental tests, depending

on adjustments to the ink formulation, desired

print resolution, or printing platform used. For

https://www.jove.com
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more information on these parameters, as well

as on the characterization of print settings with

a novel ink formulation, please refer to other

references40,44 ,45 ,46 .

3. Extrusion printing with fragmented granular hydrogels

1. For loading syringes with fragmented granular

hydrogels, see 4.2.4, as well as Figure 4 and Figure

5.

2. Remove the tip cap and replace it with a needle of

choice.

3. Load the syringe into the printing platform of choice.

Here, a custom-built screw-based extrusion printer

is used.

 

NOTE: For information on building custom

bioprinters, please see other references44,47 .

4. Load the prepared G-Code file from the planning

phase into the 3D printing software. Navigate to the

Print Preview panel and press Print.

5. As soon as the printing deposition is complete,

expose the fragmented granular hydrogel constructs

to UV light for photocrosslinking and stabilization.

6. Once crosslinking is complete, process the sample

by washing it in PBS three times.

 

Figure 5: Overview of extrusion printing with fragmented granular hydrogels. The figure depicts (A) using a spatula

to transfer fragmented granular hydrogel to a syringe barrel, (B) attaching a blunt-tip needle (18 G shown) and pushing

the sample to the top, (C) a graphic representing the connection to computer software for printing, and (D) completing the

printing of a star-shaped construct with fragmented granular hydrogel. Please click here to view a larger version of this figure.

Representative Results

Representative results from these protocols are shown in

Figure 3 and Figure 6. Extrusion fragmentation yields

microgels with jagged, polygon shapes with diameters

ranging from 10-300 µm (Figure 3). Further, circularity ranges

from 0.2 (not circular) to almost 1 (perfect circle), and the

aspect ratio ranges from 1-3 (Figure 3). These parameters

describe the irregular and jagged microgel shapes formed by

the fragmentation process.

When packed together using either centrifugation or vacuum-

driven filtration, the assembled granular hydrogel is shear-

https://www.jove.com
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thinning and self-healing, as described in the previous

work39 . In addition, the fragmented granular hydrogel has

high shape fidelity and mechanical integrity for an injectable

hydrogel, as shown by the deposition of a hollow cylinder

with a height of 2 cm being extrusion printed in Figure 6.

Fragmented granular hydrogels fabricated with these simple

and cost-effective methods are useful for many biomedical

applications, including injectable therapeutics and 3D printing

inks.

 

Figure 6: Protocol overview and representative results. The figure depicts (A) fragmentation, (B) microgels in

suspension, (C) jamming by vacuum-driven filtration, and (D) jammed granular hydrogel being extruded through a needle

and printed into a hollow cylinder. Please click here to view a larger version of this figure.

Supplemental File 1: Example .stl file Please click here to

download this File.

Discussion

Herein, methods to fabricate granular hydrogels using

extrusion fragmented microgels and packing by either

centrifugation or vacuum-driven filtration are described.

Compared to other microgel fabrication methods

(i.e., microfluidics, batch emulsions, electrospraying,

photolithography), extrusion fragmentation microgel

fabrication is highly rapid, low-cost, easily scalable, and

amenable to a wide variety of hydrogel systems. Further,

this protocol is highly repeatable with minimal batch-to-batch

variability, which was characterized in the previous work39 .

This protocol uses norbornene-modified hyaluronic acid

(NorHA) to fabricate bulk hydrogels using a photo-mediated

thiol-ene reaction. Detailed procedures for the synthesis of

NorHA are described elsewhere38 . However, many hydrogel

chemistries can be used to fabricate fragmented microgels

using the methods described herein if a bulk hydrogel can

be formed within the barrel of a syringe. It is also useful to

understand the bulk hydrogel mechanical properties (e.g.,

compressive modulus). The bulk hydrogels used in this

protocol have a bulk compressive modulus of about 30 kPa39 .

A bulk hydrogel with a higher compressive modulus will

require more force to extrude during the fragmentation steps,

which could lead to increased clogging or over-pressurization

of the syringes; thus, it is recommended to use hydrogels

with compressive moduli less than 80 kPa. Further, a bulk

hydrogel with compressive moduli lower than 10 kPa may

deform during the fragmentation steps, making it challenging

to fragment.

This protocol is optimized for a UV spot cure lamp.

As an alternative to the UV light source and UV-

https://www.jove.com
https://www.jove.com/
https://www.jove.com/files/ftp_upload/63867/63867fig06large.jpg
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responsive photoinitiators, visible light sources can also

be used along with visible light-responsive photoinitiators,

such as water-soluble lithium phenyl-2,4,6-trimethylbenzoyl-

phosphinate (LAP). Initiator concentration, light intensity, and

sample volume will influence crosslinking times depending

on the polymer and crosslinking system being used. Further,

many lamp sources can be used as an alternative to spot cure

systems.

The most critical step in the protocol is the serial extrusion

through smaller and smaller needle gauges. In this procedure,

it is suggested to use needle gauges from 18 G (838 µm inner

diameter) down to 30 G (159 µm inner diameter). Adding PBS

to the fragmented bulk hydrogel prior to extruding through

needles is crucial to significantly reduce the force needed to

extrude and fragment. No excessive force should be used to

extrude the hydrogel, as excessive force can lead to back

pressurization in the syringe and risk bursting the hydrogel out

of the syringe back. Additional strategies to reduce the force

required to extrude include using more needles in the series

to reduce fragment size more gradually, as well as adding

additional PBS between fragmenting steps.

When jamming the fragmented microgels using vacuum-

driven filtration, there may be variability in the process. Some

material systems may require more (or less) time to remove

PBS and fully jam the microgels. It is suggested to record

the time needed for individual material systems to ensure

repeatability across experiments. The time to jam will also be

dependent on the thickness and size of the sample added to

the filter. Spreading the sample out evenly across the filter

can help with uniform jamming.

The extrusion fragmentation microgel fabrication method

can be adapted for many biomedical applications. For

instance, therapeutics can be included in the hydrogel

precursor solution and subsequently encapsulated within

fragmented microgels to fabricate a shear-thinning, self-

healing granular hydrogel for localized therapeutic delivery.

In addition, fragmented microgels can be dried to allow for

long-term storage and straightforward sterilization practices.

However, one limitation to the extrusion fragmentation is the

incorporation of cells within microgels. Due to the high shear

rates during extrusion fragmentation, the method is likely

not amenable to cell encapsulation within microgels, as the

high shear may lead to significantly decreased cell viability.

Still, cells and spheroids can easily be incorporated between

microgels for in vitro culture and in vivo cell delivery.

Fragmented granular hydrogels are a promising biomaterial

for biomedical applications. In recent years, granular

hydrogels made from various fragmentation methods (i.e.,

mortar and pestle, blenders, and mesh graters) have been

used as cell-laden 3D printing inks48 , therapeutic delivery

vehicles29 , injectable tissue repair scaffolds30 , and spheroid-

culture platforms39 . Of the fragmentation methods previously

reported, the extrusion fragmentation method described

herein is one of the most simple and cost-effective methods

with numerous advantages. Sharing the methods herein will

increase accessibility to granular hydrogel fabrication and

lead to significant advances in the growing field of granular

hydrogel biomaterials, allowing more researchers to engineer

innovative biomedical solutions with fragmented granular

hydrogels.
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